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1  | INTRODUC TION

It is declared that some of the scar assessment scales for evaluat-
ing scars (Vancouver Scar Scale [VSS], Visual Analog Scale [VAS], 

Patient and Observer Scar Assessment Scale [POSAS]) can calculate 
the vascularity among other characteristics. But really they permit 
to score the grade of the scar redness, are user dependent and show 
considerable variability between raters. They do not provide any in-
formation about neovascularization of the scars. It is necessary to 
keep in mind that some treatment approaches, for example, topical 
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Abstract
Background: The application of new techniques of the scars’ correction requires the 
objective evaluation of their vascularization.
Objective: To evaluate the effectiveness of digital program ImageJ in assessing neo-
vascularization of pathologic scars.
Material and methods: In this cross-sectional study, a total of 25 patients with patho-
logic scars were enrolled. Vessel selection in the first set of digital images of their 
scars was performed by computer processing started from thresholding with subse-
quent manual correction. In the second set of the same pictures, Vessel Analysis pl-
ugin was used. Comparison of both approaches was performed by three independent 
investigators. The time required for images processing was measured.
Results: The average time that image processing and calculation have taken in the 
first group (753.3 ± 88.02 seconds) was statistically longer (P < 0.0001) than in the 
second one (358.1 ± 105.91 seconds). Independent investigators scored the preci-
sion of vessel selection in the first group as 80.4 ± 9.82, in the second group as 
72.6 ± 10.53 (P < 0.0001). Kolmogorov-Smirnov test demonstrated higher precision 
of vessel selection by method that involves manual correction (P < 0.001). The re-
sults of Vascular Density measurements were obviously overestimated in the second 
group. More expedient looks calculation of the Vascular Length Density: ratio of 
skeletonized vasculature area to total area. Skeletonization avoids overestimation of 
Vascular Density, but the density of the vessel mesh can be determined.
Conclusions: Computer processing of the scars’ digital photographs using ImageJ 
software gives cheap, technically easy and not cumbersome way of superficial scars’ 
vascularization objectifying. Vessel selection with subsequent manual correction has 
advantage of higher precision.
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glucocorticoid injections, may be responsible for the telangiectasia 
formation. Steroid-induced telangiectasia occurs due to stimulation 
of nitric oxide release from a dermal vessel endothelial cells leading 
to abnormal dilatation of capillaries.1 This effect essentially wors-
ens esthetic results of conservative scar treatment. Thus, relevant 
appears the need for using the not burdensome, fast and objective 
method for estimating the amount of telangiectasia in the scar. The 
application of new techniques and therapies requires the objective 
evaluation of a number of well-defined parameters. This enables a 
valuable scar evolution assessment and comparison of the effective-
ness of treatments by noninvasive means to be completed.2-5 The 
growing use of digital photography with their subsequent computer 
processing in medicine suggests a more objective approach to scars 
evaluation.

The objective of investigation was to evaluate the effectiveness 
of digital program ImageJ in assessing neovascularization of patho-
logic scars.

2  | MATERIAL S AND METHODS

2.1 | Study design and setting

This cross-sectional study was conducted in the Department of 
Surgery #2 of Bogomolets National Medical University and 1st 
Surgical Department of City Clinical Hospital #4, Kyiv, Ukraine. Data 
were collected from case histories and ambulatory charts. A total 
of 25 patients were enrolled into the study between May 2016 and 
March 2018. Inclusion criteria—the presence of pathologic scars. 
Exclusion criteria—narrow normotrophic scars with the color similar 
to the color of surrounding skin.

2.2 | Image processing and digital analysis

Pictures of the scar bearing areas were taken by commercially availa-
ble digital camera Panasonic DMX LC 15. Vessel selection in the first 
set of these photographs was performed by their computer process-
ing started from thresholding with subsequent manual correction. 
In the second set of the same pictures, vascular selection was done 
using Vessel Analysis plugin.

We used downloadable distribution of ImageJ/Fiji 1.46r pro-
gram6,7—a public domain Java image processing and analysis pro-
gram inspired by NIH Image. This software can display, edit, analyze, 
process, save, and print 8–bit, 16–bit, and 32–bit images.8 Its latest 
version can always be obtained from http://imagej.nih.gov/ij/docs/
guide.

Spatial calibration is available to provide real world dimensional 
measurements in units such as millimeters. To easier setting of the 
scale, the pictures were taken with the tape measure fixed to the 
skin surface. Density or gray scale calibration is also available.

The first group of digital images of the scars of all 25 patients were 
processed using thresholding, followed by the manual correction:

1.	 After opening of the original image, rectangular selection of 
the area with the scar defect was duplicated (Figure 1A). This 
permitted simultaneously duplicate and crop the image 
(Figure 1B). For future processing, RGB color image was con-
verted into 8-bit grayscale using Menu command: Image ▶ 
Type ▶ 8-bit (Figure 2).

F IGURE  1 Selection, duplication, and 
cropping of the scar bearing area. (A) 
Rectangular selection of the scar bearing 
area. (B) A new window containing a copy 
of rectangular selection

(A) (B)

F IGURE  2 Converting image from RGB color format to 
grayscale

http://imagej.nih.gov/ij/docs/guide
http://imagej.nih.gov/ij/docs/guide
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2.	 Then adjustment of threshold was performed by Menu command: 
Image ▶ Adjust ▶ Threshold (Figure 3). It should be specified 
whether or not to make the background dark or light. Adjustments 
of the minimum and maximum sliders are needed until receiving 
satisfactory saturation level of the image.

3.	 On the next step, masks were created using Menu command: Edit 
▶ Selection ▶ Create Mask. Based on the image and set threshold, 
some portions of the image may be over/under saturated. Thus 
the portion of the image that needs to be adjusted was selected. 
The tool Dilate was used to grow the included pixels to further 
saturate this portion of the image. The tool Erode permitted to 
remove saturation (from Menu command: Process ▶ Binary ▶ 
Dilate/Erode).

4.	 Selection of the objects within the mask was created using Menu 
command: Edit ▶ Selection ▶ Create Selection.

5.	 From the mask, selections were transferred to the given image. 
Before transferring the mask’s selections, the image was re-
verted to its original form. At first the mask was selected 
(Figure 4a), then the original image, and command ⇧ Shift+E 
transferred the mask’s selections (Figure 4b). From this picture, 

it is easily seen that selection needs manual correction. Not all 
small vessels, mainly at the upper part of the photograph were 
automatically selected.

6.	 If a correct segmentation of the blood vessels from the back-
ground is not obtained, manual correction should be done. 
Using hierarchy: Image ▶ Adjust ▶ Brightness/Contrast com-
mand can be opened. This helps to improve the visualization 
and facilitates the manual selection. Drawing outside current 
selection while pressing Shift creates new content. The next 
Figure 5 demonstrates the results of manual correction of au-
tomated selection.

7.	 Scar contour may be outlined by hand (Figure 6). This approach 
gives more precise results than using Color Threshold tool. All 
selections including scar outline were added to regions of inter-
est (ROI) Manager.

8.	 To present the results of measurement in calibrated units, such as 
millimeters, the spatial scale of the active image was defined. 
Before using this command, the straight line selection was acti-
vated to make a line selection that corresponds to a known dis-
tance. Then, bring up the Set Scale dialog from Menu command 
Analyse, the Known Distance and unit of measurement were en-
tered. After clicking “OK,” the Distance in Pixels field automati-
cally filled in based on the length of the line selection (Figure 7). 
Then the area of the scar, total area of the selected vessels and 
part that last one takes from the scar area in percent were 
calculated.

The alternative variant of vascular selection was studied in the 
second group of same photographs of all enrolled patients. It was 
done by the Vessel Analysis plugin. The “complete” program guides 
us through preprocessing steps to prepare the multi-channel image 
for vascular density and diameter measurements:

1.	 First of all, after opening of multi-channel image in Fiji, the 
Vessel Analysis plugin was executed (Plugins ▶ Vessel ▶ Analysis 
▶ Vessel Analysis [complete]).

2.	 Using the rectangular selection tool, we were asked to select 
the image area to analyze. Once completing and clicking OK, a 
cropped image was generated, followed by its binary version. 
The contour of the scar was transferred as an overlay from the 
multi-channel image by the help of ROI manager (Figure 8). 

F IGURE  3 Thresholding of the image

F IGURE  4 Transferring the mask’s 
selections to the given image. (A) Mask 
selections (B) Mask selections were 
transferred to the original image. Yellow 
outlines—selection of the vessels

(A) (B)



4  |     TEPLYI and GREBCHENKO

Then the following measurements were collected using this bi-
nary image:

•.	 Vascular Density: ratio of vasculature area to total selection area;
•.	 Vascular Length Density: ratio of skeletonized vasculature area to 

total area.
3.	 This plugin permits also measurement vessels’ diameter. After 

selection of a region of interest and clicking OK a colored, 

skeletonized image is generated (Figure 9). The relative thickness 
of the vessel in the selected area corresponds to some color, 
which ranges from white (thick) to purple (thin). When scaling is 
performed the average diameter of the vasculature in selected 
area (rectangle selection) may be measured in millimeters.

2.3 | Outcome measures

The adequacy of vessel selection was assessed by three inde-
pendent investigators using Visual Analog Scale (VAS)—straight 
horizontal line of 100 mm length. The left end corresponds to 
the worst adequacy, the right end—to the best adequacy. Term 
“adequacy” means that number of selected vessels and accuracy 
of selection maximally corresponds to reality. The result was ob-
tained by measuring the distance from the left edge of the line. 
The time required for computer image processing and measure-
ment was also assessed.

2.4 | Data analysis

Statistica 8.0 (Statsoft Inc., Tulsa, OK) software was used for the data 
processing. Graphical assessment of normality was supplemented 

F IGURE  5 The results of manual correction of automated 
selection of the vessels in the scar. Yellow outlines—automated 
vessel selection, Blue outlines—manual vessel selection

F IGURE  6 Outlining the contour of the scar by Freehand 
selection tool. Blue line – outline of scar contour

F IGURE  7 Setting Scale

F IGURE  8 Binary-cropped image version of the scar. Yellow 
line—outline of scar contour

F IGURE  9 Measurement of the vessels’ diameter. Yellow 
line—outline of scar contour. The samples of the vessels’ diameter 
measurement are presented in the squares
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by Shapiro-Wilk test. Some researchers recommend it as the best 
choice for testing the normality of data in not large samples.9 Data 
were presented as “mean ± SD”. The means for two groups were 
compared by an independent samples t-test. Kolmogorov-Smirnov 
test was used for comparing two not normally distributed samples. 
Differences between the samples were considered statistically sig-
nificant when P-value < 0.05.

2.5 | Ethics

This cross-sectional study was approved by the local Ethics 
Committee (Bogomolets National Medical University, Kyiv, Ukraine 
on 30th May 2016, Ref. Nr. 96).

3  | RESULTS

The average time that image processing and calculation has taken 
in the first group (753.3 ± 88.02 seconds) was statistically longer 
(P < 0.0001) than in the second one (358.1 ± 105.91 seconds).

Independent investigators scored the precision of vessel deter-
mination in the first group as 80.4 ± 9.82, in the second group, where 
Vessel Analysis plugin was used, as 72.6 ± 10.53, respectively. This 
showed that the first method is more consistent with the accuracy 
(P < 0.0001). However, in 14 cases from 150 at least one expert gave 
preference to the second method. Kolmogorov-Smirnov test demon-
strated statistically confident higher precision of vessel selection by 
method that involves thresholding followed by manual correction 
comparing to above-mentioned vessel analysis plugin (P < 0.001). 
The following picture (Figure 10) gives possibility visually compare 
the accuracy of both methods. It is obvious that automatic vessel 
selection is not completely correct.

The results of Vascular Density measurement (part of the scar 
area that selected vessels’ area takes in percent) were clearly over-
estimated in the second group. For example, in presented case first 
method of vessel selection revealed that their total area takes 15.8% 
of scar area and second method—39.0%. More expedient looks the 

measurement of the Vascular Length Density: ratio of skeletonized 
vasculature area to total area. Skeletonized vessels are represented 
by outlines of 1-pixel width. This does not allow the calculation part 
of scar area taken by vessels. At the same time, it is possible to avoid 
overestimation of the results and the density of the vessel mesh can 
be determined.

4  | DISCUSSION

Analysis of literature made by S.H. Bae and Y.C. Bae in 201410 
demonstrated that five scar assessment scales were used most fre-
quently: POSAS, VSS, VAS, Manchester Scar Scale, and Stony Brook 
Scar Evaluation Scale. Using this instruments vascularization of the 
scars may be assessed only indirectly—by evaluation of scar tissue 
color. Despite the large number of studies published in scientific lit-
erature, no ideal scar scale exists to effectively assess the vasculari-
zation of scars.10-12

Some treatment strategies, such as intralesional glucocorticoids 
injections, may have as a side effect the telangiectasia formation.13

Objective methods have advantages over scar scales.2 Their effi-
cacy is based on the use of validated tools, fundamental to ensure re-
liable outcome measurements.14 Scar vascularity have already been 
assessed using dermoscopy15 and Intravital video-capillaroscopy.5

In this investigation not expensive, easily available methods of 
computer processing of digital images were compared. Program 
ImageJ is in the free access. The use of open source tools is espe-
cially important due to their transparency and inherent ability for 
sharing and extensibility.6

Following approach may be used not only for scars assess-
ment but also for evaluation of different methods of telangiectasia 
treatment.

The obtained results have demonstrated that both presented 
variants of vessels selection do not take too much time, although it 
is much faster to use the Vessel Analysis plugin. We give the prefer-
ence to vessel selection by thresholding followed by manual correc-
tion because of its higher precision. It is wise to refine it and make 
less time-consuming.

Evaluation of Vascular Length Density from Vessel Analysis 
plugin before and after a specific treatment can be used to confirm 
the possibility of therapy to cause telangiectasias formation. On the 
other hand, this approach can provide an opportunity to evaluate 
the effectiveness of approaches to eliminate telangiectasias: laser 
therapy, radiofrequency thermal ablation, sclerotherapy.

5  | CONCLUSION

1.	 Computer processing of the scars’ digital photographs using 
ImageJ free software gives cheap, technically easy, and not 
cumbersome way of objectifying of superficial vascularization 
of the scars.

F IGURE  10 Comparison of accuracy of two methods of 
vessel selection. Yellow color—outline of vessel selection made by 
thresholding followed by hand correction that overlays binary-
cropped image of the scar produced by the Vessel Analysis plugin
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2.	 Method of vessel selection by thresholding with subsequent man-
ual correction has advantage of higher precision comparing with 
Vessel Analysis plugin, however, is more time-consuming. 
This method gives possibility to calculate the part of the scar’s 
area that telangiectasias take, which depends both of the number 
of vessels and their width.

3.	 Measurement of Vascular Length Density using Vessel Analysis 
plugin gives information about vascular net density and its change 
after different treatments, but does not give possibility to calcu-
late the part of the scar area covered by telangiectasias.

4.	 Proposed approach may be used in all situations when it is neces-
sary objectively characterize telangiectasias.
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